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1 Introduction

1.1 Welcome

First of all, CONGRATULATIONS!

You now own the world's best system for accurately, objectively and repeatably testing and auditing
blade sharpness.

SAFETY is important to Anago and we strongly recommend that you read the Safety section now.

Sharp blades can be dangerous when handled without cut-resistant or cut proof gloves.

With the Anago KST200e & KST300e you can now:

Test and record the sharpness of blades

Analyse and compare blade sharpness between people, departments and facilities

Compare blade sharpness at different times

Graph sharpness results in an easy-to-read format

Print sharpness graphs

Export sharpness tests

Control the Quality of Sharpness at your facility.
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1.2 Instruction Card

Safety FIRST

Wear appropriate cut resistant or chain mail gloves when handling blades

Ensure that everyone is well clear of the test zone while a test is running.

Running a Test

Ensure the blade clamp has been retracted

Clamp the blade into the blade clamp

Align the blade with the centre of the test media

Increment the test media and ensure that it is within the Preload range.

Click "New Test" on the Menu Bar

Click on the "New Test" button and fill in the data boxes

Click on "Start Test".  The test will run automatically.  It can be stopped
at any time by clicking on the "STOP" button.

Choose whether you want to save the test

Viewing Tests

Click "Search for Tests" on the Menu Bar

Select which tests you would like to view by entering relevant information
in each of the text boxes.  Click on the drop-down arrow to see a list of
options for each box.

Tick the "View all tests" box if you wish to see all the tests listed.

Tick whichever tests you would like to see graphed

Click the "Graph Selected Tests" button.  You will be automatically taken
to the "View Graphs" screen.  

You can view the tests in 3 ways: "Raw Data", "Clean Data", and "Score"
by clicking the relevant tab on the "View Graphs" screen.



Anago KST Series Product Manual3

© 2003-2009 ... Anago Ltd

1.3 License Information

You may use this software 14 times before a valid license code must be entered.

To obtain a License Code

The license code can be obtained by contacting Anago (sales@anago.co.nz).  You will need to include
the following information on your license code request

Your name
Your organisation
Address
Phone number
email address (if you have one)
Anago KST serial number (this can be found underneath the control box)
Product Security Key (this can be found in the About window)

Anago will not be able to provide you with a valid License Code unless you provide all of the above
information

 
Entering the License Code

Click About on the menu bar
Click the "License Code" button
Enter the License Code in the box provided
Click OK

2 Safety

It is highly recommended that the operator wears appropriate cut resistant or
chain mail gloves when loading and unloading blades into the KST Sharpness
Analyzer.

Testing sharpness of blades requires the blade to move and as such it is critical that
the operator ensures that everyone is well clear of the test zone while a test is
running.

mailto:sales@anago.co.nz
mailto:sales@anago.co.nz
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3 Setting up the KST200e/300e

3.1 Hardware

Set up the KST as per the diagram and instructions below.

Setup

Since the KST200e/300e is a highly portable device it is recommended that it be connected to a
laptop to maintain the advantages of its portability.

Connect the KST200e/300e as follows:

Plug A – A: USB (A type - flat end) male into a free USB port on the laptop / PC
Plug B – B: USB (B type - square end) male into the USB port on side of the KST200e/300e
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Signal Connectors

The right hand side of the control enclosure contains 3 signal connectors:

1. Top - Spare (4 pin) sensor socket for plug-in accessories
2. Middle - Position sensor (3 pin)
3. Bottom - Force sensor (4 pin)

These connectors cannot be interchanged

Power & Computer Connectors

The left hand side of the control enclosure contains:

1. Power supply socket and switch.
2. Fuse socket
3. USB (B type) port for connecting the KST200e/300e to a PC / laptop
4. Reset button (accessed by gently pressing the button with a thin wire inserted through the

small hole)

3.2 Calibration and Setup

The KST200e/300e allows you to set and save the top and bottom positions for the blade clamp and to
calibrate the load cell.

To Enter Calibration / Setup Mode

Press the Stop button on the keypad for 3 seconds, until the Calibration message appears
 

You may skip any part of the calibration / setup procedure by pressing the Run button on the
keypad

To Set the Top and Bottom Positions

Move the blade clamp to the required position by pressing the Up / Down buttons on the keypad
 

Press the Run button to save the current position
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To Calibrate the Load Cell

Skip the top and bottom position settings
 

When requested, remove all media from the top clamp.
 

Press either of the Up / Down buttons on the keypad and then press the Run button
 

When requested, hang a 2kg standard mass from the top clamp.
 

Press either of the Up / Down buttons on the keypad and then press the Run button

3.3 Troubleshooting

Program not starting up properly

Ensure that you have entered the correct registration details and that your evaluation period has
not expired
If you receive a message regarding files not being registered properly after following the
installation and troubleshooting process, then install SoftWire from the KST200e/300e CD.  This
will force correct registration of various components.

Program not acquiring data properly

Ensure KST200e/300e is turned on and that it is connected to the PC / Laptop
 

Ensure the KST200e/300e has been correctly identified when it is attached to the USB port.
Select "Options" on the menu bar
Click "Find COM Port". 
If attached, the software will find the COM port that the KST200e/300e is attached to
and save it as the default COM port

 

Ensure that the KST200e/300e device drivers have been correctly installed.  
These can be found on the installation CD

Test data not being saved

Ensure database in the program install folder (should be under Program Files: Anago: KST) is
NOT Read Only.  Right Click on "knifedata.ang" and select Properties.  There should be no tick
in the Read Only check box.

 

Ensure that your regional settings on the PC / Laptop are either:
Set to English (United States)   OR
Change the date format in the Regional Settings (under Control Panel) to "M/d/
yyyy"

KST200e/300e displaying error messages

If "Test Error" is displayed on the LCD screen, you will find a letter code on the right hand side
of the screen (e.g. "-c-").  These codes refer to the following errors.

"a" - preload cannot be calculated.  This is usually caused by an inability to collect
data.  Check the connections to the load cell and potentiometer and repeat the
test.  Contact Anago if this does not resolve the problem.
"b" - the KST200e/300e cannot detect an initial peak in the data.  This can be
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caused by a test run without a blade inserted.  Load a blade and repeat the test.
"c" - no peaks have been detected.  This can occur if the preload is set to the
incorrect level (usually too high).  Try setting the preload to the top red line - 7.5 -
8.0.
"d" - error converting the detected forces into the Anago Sharpness Score.  Repeat
the test and contact Anago if the error is not resolved.
"e" - error calculating the overall score.  Repeat the test and contact Anago if the
error is not resolved.
"f" - error calculating the overall score.  Repeat the test and contact Anago if the
error is not resolved.
"g" - error displaying the test results on the LED display.

If the KST200e/300e will not respond to the buttons on the key pad, press the Reset button
located beside the USB port.  You will require a paper clip or similar object to reach through the
hole
Rerun the calibration procedures after resetting the KST200e/300e to restore top and bottom
positions and correct load cell calibration settings

Support / Suggestions

Please contact support@anago.co.nz if you require help, wish to offer suggestions for added features
or wish to report a software fault.

4 Installing the Software

Installation

ENSURE that you are logged on with a username that has ADMINSTRATOR privileges.  This must
be done before new programs can be installed.

1. Place the Anago KST200e/300e CD in the CD Drive.  The Setup program should run
automatically.  

2. Plug the Anago KST200e/300e into a free USB port on your PC / Laptop  
3. Windows™ will detect the KST200e/300e and request the correct drivers for it.  These can

be found on the Anago KST200e/300e CD
4.    The driver detection process is a 2 step process and can take up to 10 minutes to complete
5. If your version of Windows  cannot detect the correct drivers on the CD, connect to the

Internet and allow Windows  to automatically search Windows Update for them.  This
process can take up to 15 minutes.

6. Follow the screen instructions from there, rebooting if requested.

On program startup you may receive a request to place the "Office 2000 Professional" disk into the
CD.  If you do happen to have this disk, then do so.  This seems to be a Windows XP thing and
Office is not installed on the laptop by placing the disk in the CD.  For this purpose, you may use any
copy of Office 2000 that you own.  A file "Data1.cab" has been included on the KST200e/300e install
CD and may solve the problem if you browse to it instead of the Office 2000 Pro CD.
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Opening

Select the program start icon  from the Start Menu: Program Files: Anago KST.  

This icon can also be found on the Desktop and if this is done, the program can be opened by double-
clicking the KST200e/300e icon. 

Closing

Click the X on the top right of the program window

OR

Select "Exit" from the File menu. 

5 Operating the KST without a PC

A new feature on the KST200e/300e is the ability to perform sharpness tests without a PC / Laptop
attached to the device.  The LCD (text) and LED (lights) displays allow you to calibrate, control and
analyse the KST200e/300e and sharpness test results.

The KST200e/300e can still be attached to and controlled by a PC / laptop if you wish to create a
permanent record of your results.

Anago maintains a continuous improvement policy and the improved accuracy of the PC software may
mean that the score generated by the device is different from the score generated by the PC.  If this is
the case, use the score from the PC.  It is the PC score that is saved in the test database.
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5.1 The Keypad

To switch the KST200e/300e on / off

Switch the main power switch on.  This is located on the left hand side of the KST200e

Press the Power button on the keypad

To Position the blade clamp

Press the Up or Down buttons on the keypad to position the blade clamp.  The clamp will stop once
you cease pressing the Up or Down button.

To Stop the blade clamp

Press the Stop button to stop whatever motion may be occurring.  This may be a test, retraction or
self-test.  The Stop button works in Manual and Auto modes.
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To Run a Test

Ensure that the test media is clamped at the appropriate Preload Level.  The LED display should
show all LEDs in the Green zone (recommended level of 8.0) when the test commences.

Retract the blade or move it to an appropriate starting position

Press the Run button on the keypad

The test will run automatically, stop and then calculate and display the resulting score on both the
LCD (text) display and the LED (lights) display.

To Retract the blade clamp

Press the Retract button.  The KST200e/300e will retract the blade clamp to its top position.

To Run a Self-Test

Press the Self-Test button.

The KST200e/300e will run the blade clamp down to its lowest position wait for approximately 1/2 a
second and then return to its top position.

To switch between Auto and Manual operating mode

Press the Manual / Auto button on the keypad to move between Manual and Auto modes.  The
Manual Mode indicator will light when the KST200e/300e is in Manual Mode.

When in Manual Mode:
The KST200e/300e will not respond to any motion commands from an attached PC / Laptop.
 
All motion control (including running a test) will need to be performed on the keypad
The KST200e/300e will calculate the score locally and display the results
The LCD display will show "Man" at the bottom right hand corner

When in Auto Mode:
The KST200e/300e can be controlled by either an attached PC / Laptop or the keypad.
The KST200e/300e will not calculate or display the score locally.
The LCD display will show "Auto" at the bottom right hand corner
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5.2 LCD (Text) Display

The LCD display:
lets you know what is happening
shows system messages
displays the operating mode (Manual, Auto)
displays the overall sharpness score
displays the PCB serial number, hardware & firmware version when the KST200e/300e is switched
on
displays the force applied to the load cell (in kilograms)
displays the test mode (sharpness, roughness)
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5.3 LED (Lights) Display

The LED display is used to display the Preload Level and the final Sharpness Profile of a blade.  All
LEDs below 8 are RED and all LEDs above 8 are GREEN.  

Reading the Preload Level

Prior to a test being run the LED display continually displays the force being applied to the load
cell.

 

Tension the test media until the Green LEDs between 8.0 and 8.5 are lit when the test starts. 
Due to the relaxation of the test media you may need to set the tension to above 9.0 so that the
LEDs are still in the Green Zone when the test starts.

Reading the Sharpness Score Profile

After a test has been completed and the Sharpness Score calculated, the LEDs display a profile
of the sharpness along the length of the blade

 

Each section of the blade is divided into blocks of 20 mm lengths from the tip to the end of the
test

 

All scores in each block are averaged and corresponding LED is lit
 

8.0 is the recommended minimum score for a blade used for professional food processing.  All
scores above this level are displayed as Green and all scores below 8.0 are displayed Red.
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5.4 Running a Test

The KST200e/300e allows you to set the preload and run a test without a PC being attached.

Setting the Preload

Tension the test media until the LED display shows all Green LEDs after clamping

Running a Test

Locate the blade clamp to the required start position
 

Press the Run button on the keypad

5.5 Charging the Battery

The battery is automatically charged whenever the KST200e/300e is plugged into a mains power
supply.

The charge indicator on the keypad will light when the KST200e/300e is in Charge mode
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6 How to Test Blades

6.1 Preparing the Blade

Clamping

1. Ensure that the knife to be tested is clean of fat, blood and other contaminants that may alter
the sharpness reading.

2. Place the blade in the blade clamp, between the two sets of clamping prongs and pressed
against the bottom of the blade clamp

3. Tighten the prongs until the blade is firmly clamped.

Angle

Set the angle of the blade so that the tip is the first point to touch the test media. 
Use the same angle when testing similar blades, e.g. use the same angle for all skinning knives
of a given size and shape.
The above can usually be achieved by always looking to set up the blade so that the top surface
of the tip is approximately horizontal when clamped.

Alignment

Align the blade so that it is approximately in line with the centre of the test media along the entire
test section of the blade.  
This is done by tightening / loosening the clamping prongs on either side of the blades.

Testing Blades with Blunt Tips

The recommended method of testing blades with intentionally blunt tips is to clamp the blade as
required, manually position the clamp so that the tip of the blade is just touching the test media and
then cut the horizontal strands that will be hit by the intentionally blunt portion of the blade.  This will
allow the tip of the blade to penetrate the media easily while also recording the sharpness of the
remaining sections.
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6.2 Preparing the Test Media

Top Self-Locking Clamp

Feed the test media through the self-locking clamp as shown in the pictures below.
Press down the flat lever inside the clamp to create a space to feed the test media through.

The top self-locking clamp is loosened by pulling on media that has already been passed through it
and tightened by pulling down on the test media that leads down to the bottom clamp. 

Bottom Clamp

The bottom clamp is opened and closed via the lever attached near the clamping jaws. The tension on
the jaws can be adjusted by tightening and loosening the lever while the clamp is open.
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Clamping the Test media

The test media is fed between the jaws of the bottom clamp, under the media roll bar and up through
the self-locking top clamp.  The media rollers and brackets supplied can be used to keep the used
and unused test media out of the way and simplify incrementing between tests.

Increment between Tests

1. Open the bottom clamp
2. Pull the test media up through the clamps until the bottom of the slit cut during the previous

test is 40mm above the point at which the next blade will start to cut the media.  The exact
location of this position will vary with blade length and shape.

3. The excess media hanging out of the top clamp can be rolled around the top media roller
provided.  This roller contains a small slot that the end of the media is pushed into.  The roller
can then be rotated to tidy away the excess media.

Retracting the Blade

It is recommended that the bottom clamp is opened prior to the blade being retracted.  This prevents
the top of the knife catching on the test media as the knife is retracted.

6.3 Run a Sharpness Test
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Step-by-Step

1. Open the program

2. Load the blade to be tested and align it to the centre of the test media.  See Preparing the
Blade  for more detailed instructions.

3. Select "New Test" on the menu bar

4. Click the "New Test" button

5. Retract the clamp by clicking the "Retract Blade" button if the clamp is not already retracted.

6. Increment the media and tension it until the LED display on the KST200e/300e shows all Green
LEDs after clamping.  Since the test media has some stretch in it, you will need to clamp the
media while the preload is at the 9 or 9.5 level on the LED display and wait for it to relax back
to the 8.5 or 8.0 level prior to running the test.  Gently stroking the test media after clamping
will reduce the time taken for the media tension to drop to the required level.

7. Enter the test details in the boxes provided.  Click on the down arrows on the right of each box
to open a list of previously entered data.  All boxes apart from SCORE and MEMO need to be
completed before the test will save.  Use the drop down lists as much as possible to prevent
typos.

8. Start the test by clicking the "Start Test" button

9. The test then runs and stops automatically.  It can be stopped at any time by clicking the
"STOP TEST" button

10. A screen will pop up asking you if you wish to save the test.  Make your selection.  If the test is
saved then you will be automatically transferred to the "View Graphs" screen.  If you choose to
save but have not completed all the test details then the test will not save and the program will
return you to the "New Test" screen so that you can fill in the incomplete boxes.  You can then
save the test by clicking the "Save Test" button.

11. The "View Graphs" screen can also be reached by clicking on View Graphs on the Menu Bar
on the top of the screen.

12. Within the "View Graphs" screen there are 3 ways to view the test results.  Each of these can
be found on the tabs "Raw Test Data", "Clean Test Data" and "Score". 

"Raw Test Data" shows the data as it was recorded by the KST200e/300e.
"Clean Test Data" shows a peak analysis of the data with the initial flat (prior to
the blade hitting the media) removed.

"Score" shows a conversion of the peak analysis data into a score out of 10.  This
score is then averaged to obtain an overall score for the blade.

13. Unload the blade

14. Retract the clamp

14
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7 How to View Previous Tests

7.1 Finding Saved Tests

1. Select "Search for Tests" 

2. Choose the criteria you want to use to narrow down the list of tests.  Do this by entering a value
in one or more of the boxes provided.  You can also use the drop down arrows to select values
from those stored in the database.

3. The list of tests will update automatically once you make a change in any one of the criteria
boxes.

4. Tick the tests that you would like to see graphed

5. Clicking the column headings on the test list will change the sort order of the tests and can be
a useful way to find the test(s) you want.

6. Select the "Best" test to compare your results against [optional].  You must have something in
the corresponding criteria box (e.g. a person's name must be entered in the Person box if you
have selected the "Best for This Person" option).

7. Click the "Graph Selected Tests" button. 

8. You will be automatically taken to the "View Graphs" screen so that you can view the tests.
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7.2 Viewing Graphs

1. You can view the test results in 3 different ways: 
Raw Test Data (Low Force is good) 
Clean Test Data (Low Force is good)
Score (High Score is good). 
Click on the relevant tab to move from one view to another without needing to re-
select the tests

2. It is recommended that a score of 8 be used as the minimum acceptable sharpness level
when evaluating training and auditing sharpening ability.

3. The Test List is still visible in this screen (in fact it is visible in all screens) and tests can be
ticked and un-ticked to change which tests are graphed.  

4. Click the "Update Graph" button to graph all ticked tests.

The KST200e automatically takes into account variations in preload between and within
tests to ensure that you can be confident that your comparisons can be relied upon.
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8 Manipulating Tests

8.1 Deleting Tests

1. Click on the unwanted test in the test list so that the unwanted test is highlighted

2. Press the Right Click button on your mouse while the pointer is on the test list

3. Select "Delete Highlighted Test"

4. Click OK on the Delete Confirmation message

5. The highlighted test will be deleted and the test list will automatically update to show that the
unwanted test is no longer present.

8.2 How to Ignore the Score at the Tip of the Blade

Some processing tasks require the tip of a blade to be blunt.  In this case you would want the Anago
Analysis Software to ignore the force at the tip of the blade when calculating your score.  

To ignore the tip in the score calculation:

1. Click on the test you wish to change in the test list so that the test is highlighted

2. Press the Right Click button on your mouse while the pointer is on the test list

3. Select "Ignore Initial Peak on this Test"

4. The highlighted test will be altered and the test list will automatically update.
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To include the tip in the score calculation:

1. Click on the test you wish to change in the test list so that the test is highlighted

2. Press the Right Click button on your mouse while the pointer is on the test list

3. Select "Don't Ignore Initial Peak on this Test"

4. The highlighted test will be altered and the test list will automatically update.

8.3 Checking Database

Every now and then improved program improvements will require changes to be made to the database
in which your tests are stored.  

If this occurs you will be advised to click on the "Check Database" option in the Tools menu to ensure
that your database will be able to work with the upgraded program version.  

This does not affect the raw data saved for the tests.

Your previous program version will still work with the database if you choose to revert back to it.
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8.4 Updating Scores

Every now and then improved score generation algorithms may be included in software updates.  

If this occurs you will be advised to click on the "Update Recorded Scores" option in the Tools menu
to ensure that all previous tests are scored in the same way that new tests will be.  

This does not affect the raw data saved for the test, only the Score generated from it.

8.5 Delete All Tests

DANGER!!
This function will delete all of your test data!  Make sure you have a backup before using it and only
use it if you really mean to.

To delete all of the tests saved on this computer, click on the "Delete All Tests" option in the Tools
menu.  

This will completely clear your test database, which also means the dropdown lists in the New Test
and Search for Tests screens.  

You will NOT lose any licence information or software settings. Only the test data is deleted.
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9 How to Print Tests

Before you can print any graphs from the Operating & Analysis Software you must already have a
printer installed on the computer (see the instructions that came with your computer) and your
required printer must be set as the default printer (see instructions that came with your computer and/
or Windows™ help).

1. Select "Print" from the File menu.

2. Select the chart(s) that you wish to print.  

3. Click the "Print" button.  A standard Print dialog box will appear.  Select the appropriate options
and click "OK"

4. The graph will be sent to the default printer connected to your computer.
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10 How to Export Tests

Data is exported from the Anago Analysis Software in comma delimited (.csv) format for easy
importing into spreadsheet applications.

1. Select "Export" from the File menu.

2. Choose which export options you wish to use. 
Test Info is all the information relating to a test, including the score.  The information
from all the chosen tests are stored in a single file.
Test Data is the actual sharpness data recorded during each test.  The Test Data from
each test is exported into a separate file.

 

3. Type or browse to the folder that you wish to save the export file to.

4. Click the "Export" button.

11 How to Control the KST from your Computer

The movement of the KST200e/300e blade clamp can be controlled manually from the software by
clicking "Manual Controls" at the top of the screen.  

These functions can be used to manually reposition the blade clamp to any desired location.
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Note: The KST200e/300e must be in Auto Mode for the device to be controlled via the Software. 
Refer to the Keypad description  for more details.

Repositioning the Blade Clamp

The blade clamp can be moved up and down by clicking on the "UP" or  "DOWN" buttons.  
When moving the clamp can be stopped by clicking the "OFF" button.

Self-Testing

Clicking on the "Self Test" button will cause the KST200e/300e to complete a cut and retract
cycle with the blade clamp.

The KST200 can run multiple self-test cycles when a number greater than 1 is entered in the
box beside the "Self Test" button.

Clicking the "OFF" button will stop the Self-Test cycle.

Obtaining Test Data

Clicking on the "Get Test Data" button will capture the most recent test performed by the
KST200e/300e.  

The test data is only stored in the KST200e/300e until it is switched off.

Obtaining Device Version

Clicking on the "Device Version" button will display the firmware version installed in the
KST200e/300e.  

9
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12 Software Options

The Options screen can be reached by Selecting the "Options" at the top of the screen.

Use these options only after you have become familiar with the other functions of the KST200
Operating and Analysis Software.

Expert SQL Querying

Only alter the SQL statement if you are familiar with this database querying language. 

The SQL statement contained within the large box is updated every time the test list is
updated.   
Alter the SQL statement to enable even more precise querying of the database of tests
Click the "Update Test List" button to update the test list using the modified SQL query.
Click the "Regenerate Code" button to generate the SQL code that matches the selections in
the "Search for Tests" screen.
Tests can then be viewed as described in Section View Graphs , above.

Calibration of Load Cell

The load cell can be calibrated by clicking on the "Calibration" button.  Follow the instructions
on the KST200e/300e LCD display.
The process requires the use of a standard mass of 2kg which can be sourced from Anago or
from your local supplier of weighing equipment.
This has already been performed by Anago prior to the product shipping and should be repeated
every 1 to 2 months and whenever the KST200e/300e has suffered significant vibration (e.g.
during transport or from a knock).  

19
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Finding the Comm Port

The communication port used to interact with the KST200e
Connect the PC to the KST200e/300e with the USB cable.
Turn on the KST200e/300e so that the LCD display is showing text.
Click the "Find Comm Port" button.
The software will automatically detect the Anago KST200e/300e and display the Comm Port it
is attached to.  It may be necessary to repeat the search if the detection fails to find the
analyzer at first.

Default Device

Select the model number of the KST unit that you have, e.g. KST200e/300e.  
This ensures that the internal software settings are correct for operating your unit.  

Default Plant

Type or select the plant that you wish to show by default when running new knife tests. 

Default Chart

Select the chart format that you would like to appear after each test.  
You are still able to view the other charts by clicking on their respective tabs.

Altering Graph Options

The graph legend can be turned on and off.  
The maximum and minimum zoom scale can be altered when zooming in on graphs

Roughness Analyzer Options

The KST200e/300e can operate as an Edge Roughness Analyzer if the optional Roughness Testing
Kit is installed.

13 Backing Up Your Data

13.1 Creating Backup File

Step 1: Open the start menu, select 'all programs' icon and scroll dow n to the Anago folder
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Step 2: Open the 'Anago' folder, click on the 'Anago KST200e' folder and then click on the 'Back up and Restore' icon.
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Step 3: After clicking on the backup and restore icon, this w indow  w ill appear. Click on the create backup button.

Step 4: Once the 'Create backup' button has been clicked, this w indow  w ill pop up. Click 'OK'. You have now  created a

backup f ile.
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13.2 Restoring Data from Backup File

Step 1: Open the start menu, select 'all programs' icon and scroll dow n to the Anago folder

Step 2: Open the 'Anago' folder, click on the 'Anago KST200e' folder and then click on the 'Back up and Restore' icon.
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Step 3: Click on the button w ith three small dots on it to f ind the backup f ile that you w ant to use for the restore.

Step 4: Double click on knife data backup and it w ill take you back to the w indow  show n in step 3.
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Step 5: Click on 'Restore Backup' button and data from backup f ile w ill have successfully been restored.
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13.3 Sending Backup File to Someone Else

Step 1: Once the backup has been created click on the button w ith three small dots on it.

Step 2: This w ill open up a new  w indow . Right click on the backup f ile and scroll dow n to 'send to'.
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Step 3: Select mail recipient and your computer should take you to your default email.
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14 Specifications and Maintenance

14.1 Care and Maintenance Instructions

Care

Data Cables (such as that which joins the KST200e/300e to the computer) can break at the
point where they connect to the computer and/or KST200e/300e.  Care needs to be taken to
prevent this connection receiving knocks or other sources of bending stress.

Maintenance

Note: There are no user serviceable parts inside the KST200e/300e.  Opening the
control enclosure without authorisation may create danger and will void any
warranty arrangements you may have.

Battery

The KST-200e/300e will enable approximately 80 knives to be evaluated when the battery is
fully charged.
The battery will recharge automatically between tests when it is plugged into a power supply
and the main power switch is turned on
To recharge the KST-200e/300e at the end of each shift / day.  

o Turn OFF the KST-200e/300e using the Power button on the keypad
o Ensure that the power cord is plugged into a suitable mains power supply and the

power switch is ON
o The charge light on the KST200e/300e keypad will glow while the battery is charging

The battery will eventually discharge if the KST-200e/300e is left ON and it is not plugged into
the mains power supply. 

o The motor will sound slow long before the battery is fully discharged and provides
sufficient warning that charging is required.

o The KST200e/300e switches itself OFF after a few minutes of inactivity to minimise the
risk of the battery discharging fully

Drive Motor

The drive screw on the motor requires regular lubrication.  Check the lubrication level weekly
and lubricate if required, but no less frequently than monthly.  Food grade lubricant is
preferable due to the proximity of the drive screw to the knife blade.
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Load Cell Assembly

The mounting screws for the load cell may loosen with time.  
o Check daily and tighten as required.  
o Apply a small amount of glue to prevent the screws loosening if the vibration levels in

the location chosen for the KST200e/300e are such that the screws require tightening
frequently.

14.2 Product & System Specifications

Items Included in Your Package

KST200e/300e Sharpness Analyzer
Anago KST200e/300e Operating & Analysis Software
Anago KST200e/300e Device Drivers (included on Anago KST200e/300e CD)
USB Cable
Power Cable
2 FREE rolls of analyzer media (sufficient for up to 300 tests, depending on blade length being
tested)
2 media roll shafts for mounting into media shaft brackets.  The slotted shaft fits into the top
media shaft bracket.

All contained within a sturdy case that enables you to take the KST200e/300e anywhere.

KST200e/300e Specifications

Power supply for KST200e/300e = 230/240 VAC, 50 Hz  or 110 VAC, 60 Hz
Fuse = 5 A, M205, Fast Blow
Dimensions 

KST200e = 540 x 475 x 200 mm (L x H x W)
KST300e = 700 x 475 x 200 mm (L x H x W)

Weight
KST200e = 14 kg
KST300e = 15 kg

PC System Requirements

Pentium III or later
128 Mb RAM or greater for Windows 2000, 256 Mb RAM or greater for Windows XP, 512 Mb
RAM or greater for Windows Vista
CD Drive
USB port
150 Mb free space on hard drive to allow for program installation and storage of test data
Windows 2000, Windows XP, Vista.  Windows NT is not supported.
Screen resolution 1024 x 768 or greater
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14.3 Spare Parts List

Spare parts can be ordered from Anago via email to sales@anago.co.nz

The following table lists the spare parts available for the KST200e/300e, along with their corresponding
part number.  

Please use the part number when ordering replacement parts or test media.

Contact Anago at sales@anago.co.nz for up-to-date pricing.

Part Code Part Description

KST-LDC-18 Load Cell Assembly - 18 kg capacity

KST-TM-5 Test media – 5 roll pack, 25m per roll

KST-LCP Lower media clamp

KST-TCP Top media clamp

KST-CP-4 Clamping Prongs - 4 pack (used to clamp the blade, excludes T-screws)

KST-BAT-2Ah Battery

KST-MOT-200 Motor with lead screw for KST200e

KST-MOT-300 Motor with lead screw for KST300e

mailto:sales@anago.co.nz
mailto:sales@anago.co.nz
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